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1. Understanding your CADfix purchase 
Your CADfix license will be one of the following types: 

• Evaluation 

• Single node-locked 

• Network (floating), or multiple node-locked 

Other installation configurations are available, and CADfix support can provide more advice if needed. 

 

Within this document, each of these license types is colour-coded (as above) to help with identification 

of the relevant information. 

 

 

 

Evaluation 

This installation uses a local license file that is time limited. It does not require any licensing services, 

so only CADfix needs to be installed. Evaluation licenses do not normally allow remote access, but this 

license can be installed on multiple computers. 

 

 

Single node-locked 

A node-locked installation is locked to a specific computer which is identified by its host-id (MAC 

address). Both the CADfix application and the license services are usually installed on the same 

computer. 

 

Where a purchase includes multiple node-locked seats, the installation can follow the ‘Network 

(floating), or multiple node-locked’ procedure.  This allows all the CADfix installations to share a single 

license server. 

 

 

Network (floating), or multiple node-locked 

A floating CADfix license will run only on a specifically defined range of computers. The allowable range 

should be discussed with the CADfix sales team before the purchase and will be categorised as LAN, 

WAN, RWAN, or WWAN depending on the locations of required users. Each allowable computer within 

this range will be identified using one of the following options (or combination): 

 

IP address range: 126.10.10.* 
IP address list: 126.10.10.5  126.10.10.6  126.10.10.7 

MAC address list: 48ad3f56ffcb a93b2f2dd9ab  e8ff3ba826c0 
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2. Quick installation guide 
 

 

2.1. Evaluation 

Preparation 

a)  Request an ‘Evaluation’ license file. 

Usually supplied via your CADfix sales representative by email.  

or: 

Americas customers - email works_supp@iti-global.com  

Non-Americas customers - email eukeys@iti-global.com  

b)  Download CADfix 

The latest download link is supplied in the license file email that was sent to you - Download the ‘Installer’ 

package. 

A ‘Zip file’ installation is also available for download (not covered in this installation document). 

Installing CADfix and license  

c)  Install CADfix 

Run the downloaded installer program – See section Installing CADfix 

d)  Copy your license file into “..\CADfix 13 DX\lic” 

When received from ITI, copy the license file into the CADfix lic folder.  

e.g. “C:\Program Files (x86)\CADfix 13 DX\lic\” – See section Local license file 

e)  Run CADfix 

Double click on the desktop icon. 

Or run the “startCADfix.bat” script in the CADfix installation folder 

”C:\ Program Files (x86)\CADfix 13 DX\ startCADfix.bat” 
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2.2. Node-locked (single) installation 

For this installation type the client workstation and license server are usually the same computer. 

If the license is to be installed on another computer, or multiple node locked installations are to share a 

license server, then follow the instructions for a Network installation (below). 

Preparation 

a)  Request a ‘Node-locked’ license file. 

Americas customers - email works_supp@iti-global.com  

Non Americas customers - email eukeys@iti-global.com  

Or via your CADfix sales representative. 

 

To create the license file, the ITI support team will need to know: 

• CADfix license server’s network name. 

• CADfix workstation(s) Host id – See Managing the license and services 

b)  Download CADfix 

The latest download link is supplied in the license file email that was sent to you - Download the ‘Installer’ 

package. 

A ‘Zip file’ installation is also available for download (not covered in this installation document). 

Installing CADfix and license 

c)  Install CADfix 

Run the downloaded installation program – See Installing CADfix 

d)  Copy your license file into “..\CADfix 13 DX\lic”  

When received from ITI, copy the license file into the CADfix lic folder  

e.g. “C:\Program Files (x86)\CADfix 13 DX\lic\” – See Managing the license and services 

e) Install FlexNET services 

See Configuring the license manager. 

f)  Run CADfix 

Double click on the desktop icon, or run the “startCADfix.bat” script in the CADfix installation folder 

e.g.”C:\Program Files (x86)\CADfix 13 DX\” 
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2.3. Network installation – for floating, or multi-nodelocked 

This installation allows the CADfix workstation(s) to fetch licenses from a shared license server. 

Preparation 

a)  Request a license file. 

Usually supplied via your CADfix sales representative by email.  

or: 

Americas customers - email works_supp@iti-global.com  

Non-Americas customers - email eukeys@iti-global.com  

 

To create the license file, the ITI support team will need to know: 

• CADfix license server network name or IP address 

• CADfix license server MAC address 

• CADfix workstation IP address list/range, or MAC address list. 

(If a ‘multiple node-locked installation’ then this must be a MAC addresses list). 

b)  Download CADfix 

The latest download link is supplied in the license file email that was sent to you - Download the ‘Installer’ 

package. 

A ‘Zip file’ installation is also available for download (not covered in this installation document). 

Install CADfix license server 

c)  Download and install the CADfix license server software onto the license server or copy a lic folder 

from an existing CADfix client installation.  - Download the license server only from www.cadfix.eu/13LIC/  

d)  Copy your license file into “..\CADfix DX 13\lic” 

When received from ITI, copy the license file into the CADfix lic folder.  

e.g. “C:\Program Files (x86)\CADfix DX 13\lic\” – See Installing the license service 

e) Install FlexNET services  

For detailed instructions about installing the FlexNET services – see Configuring the license manager 

Install CADfix on client workstations 

f)  Install CADfix 

Run the downloaded installer program – See Installing CADfix 

g) Link CADfix to license server – See Linking CADfix to the license 

h)  Run CADfix 

Double click on the desktop icon, or run the “startCADfix.bat” script in the CADfix installation folder 

e.g.”C:\Program Files (x86)\CADfix 13 DX\” 
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3. Installing CADfix 
The link on the CADfix download page will provide a Windows installation executable that is specific to 

the CADfix type and version that you are downloading. The exact name of this installer will change 

depending on the type and version of CADfix being installed, e.g. CADfix13SP1DX_WINNTx64.msi 

 

Note: The example images shown below are generic.  Installing a specific CADfix product will use the 

same installation screens but will have different version numbers and installation locations. 

 

 

1) Double-click on the downloaded installation file to 

start the installation process. 

 

 

2) The Welcome screen is displayed: 

a) ‘Next’ continues with the installation 

process. 

b) ‘Cancel’ will stop the installation process. 

 

 

 

3) The CADfix Software License Agreement is displayed. This should be reviewed carefully to ensure 

your use of CADfix adheres to the license that you have purchased. 

 
• Select ‘I accept the terms in the license agreement’ to acknowledge you have read and 

understand the agreement. 

• If you have any questions about the agreement or are worried that it does not reflect your 

intended use of the software, then please contact your reseller to discuss this further. 

 

a) ‘Back’ returns to the ‘Welcome’ screen. 

b) ‘Next’ continues with the installation process. 

c) ‘Cancel’ will stop the installation process. 
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4) The default installation location is shown: 

 
a) ‘Change…’ allows CADfix to be installed at a different location. 

b) ‘Back’ returns to the ‘Software License Agreement’ screen. 

c) ‘Next’ continues with the installation process. 

d) ‘Cancel’ will stop the installation process. 

 

 

 

5) The default language for the CADfix interface is show. 

Note that this selection does not affect the language used during the installation. 

Speak to CADfix support if you need to change the language after the installation has completed.  

 

• Select the language you want to use in the CADfix interface. 

 

a) ‘Back’ returns to the ‘Choose Destination Location’ screen. 

b) ‘Next’ continues the installation and sets the default language as specified. 

c) ‘Cancel’ will stop the installation process. 

 



CADfix Installation Guide for Windows - CADfix 13.0 

Public 
ITI - International TechneGroup Limited  Page 9 of 37 

6) The ‘Ready to install’ screen provides a last opportunity to change the settings before the 

installation process starts: 

 
a) ‘Back’ returns to the ‘Language’ screen. 

b) ‘Next’ starts the installation of CADfix using these settings. 

c) ‘Cancel’ will stop the installation process. 

 

 

 

7) Windows will ask for permission to start running the installer. 

   
a) ‘Yes’ allows the installation process to start. 

b) ‘No’ stops the installation process from running. 

 

CADfix13SP1DX_WINNTx64 
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8) During the installation of the files a progress bar is displayed: 

 
a) ‘Cancel’ will stop the installation process. 

 

 

 

 

9) A finishing message is displayed to show that the installation has been successfully installed.  

 
a) ‘Finish’ closes the installer. 

 

Note: Do not attempt to pin the CADfix to the Windows Task Bar. This will cause a startup error. 
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4. Managing the license and services 
CADfix utilises FlexNET license services for its license management. If it is needed, and where it is 

installed will depend on the configuration of your CADfix purchase. For all license types CADfix will 

need a license file generating. – Contact CADfix support to request a license and for any advice. 

 

If your designated license server already hosts another FlexNET license server, then see section 

Utilising an existing FlexNET license server before moving on to section Configuring the license 

manager 

 

Evaluation license 

The license server is not needed for an evaluation license and CADfix support can send out an 

evaluation license without any further information.  

To run an evaluation license: 

1. Ensure the supplied license file is named ‘cadfix.dat’. 

2. Copy cadfix.dat to the CADfix lic folder (e.g. “C:\Program Files (x86)\CADfix 13 DX\lic\”) 

 

 

Node-locked (single seat) license 

When a license manager is required on the same computer as the CADfix application, the license 

manager can be run from within the CADfix installation. Alternatively, the license manager can be 

installed in a non-version specific location to avoid reconfiguration during subsequent upgrades of 

CADfix (see ‘Floating and Multi-seat node-locked licenses’ below). 

 

CADfix support will need to know the workstation’s host id: 

1. Using the file browser, open the CADfix license server 

installation folder. Then run lmtools.exe. 

 

2. If the User Account Control dialogue box appears, click ‘Yes’ to 

allow ‘LMTOOLS Utility’ to run. 

 

3. When LMTOOLS starts, open the ‘System settings’ tab. 

 

4. The Host id is shown in the ‘Ethernet’ field highlighted below: 
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Floating and Multi-seat node-locked licenses 

To install the license manager software as a server there are three options available: 

1. Install a full CADfix installation on the server. This will include the full FlexNET license server. 

2. Download the license server installation package (https://www.cadfix.eu/13LIC/ ). 

The installation procedure is the same as the full CADfix installation and is therefore not 

repeated here. 

3. Copy the lic folder from a CADfix installation onto the server at a static location where it can be 

run (e.g. “C:\Program Files (x86)\CADfix license\”). 

 

For options 2 and 3 above, it is good to install the CADfix license in a non-version specific location to 

avoid reconfiguration during subsequent upgrades of CADfix. e.g. “C:\Program Files (x86)\CADfix 

License” 

 

For this type of installation, CADfix support will need to identify a list of allowable computers for CADfix 

use. This is a list in one (or a combination) of the following formats: 

• The IP address range. 

• A list of host-ids for the specific computers.  
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4.1. Configuring the License Manager 

This configuration process shown here uses the FlexNET graphical user interface to configure Windows 

services. The process can also be completed at the command-line and this process can be requested 

from CADfix support. 

 

1. Using the file browser, open the CADfix license server installation folder. 

This folder contains: lmtools.exe, lmutil.exe, lmgrd.exe, and itiohio.exe 

 

 

2. Place a copy of the license file (cadfix.dat) into this installation folder. 

This is a text file containing: your license information, details of the license server, and information 

about which computers can run CADfix.  This may be supplied to you with a different name and will 

therefore need renaming to ‘cadfix.dat’. 

 

 

3. Right-click on lmtools.exe and select ‘Run as 

administrator’ to start the License manager interface 

tool. 

 

 

 

 

4. If the User Account Control dialogue box appears, click ‘Yes’ 

to allow ‘LMTOOLS Utility’ to run. 

 

 

 

 

 

5. When LMTOOLS starts, open the ‘Service/License File’ tab, and select ‘Configuration using 

Services’: 

  



CADfix Installation Guide for Windows - CADfix 13.0 

Public 
ITI - International TechneGroup Limited  Page 14 of 37 

6. Open the ‘Config Services’ tab and set the values: 

 ‘Service Name’ = “CADfix License” (Type this directly into the box) 

 ‘Path to lmgrd.exe file’ = Browse and select the lmgrd.exe file in the license installation folder. 

 ‘Path to license file’ = Browse and select the cadfix.dat file in the license installation folder.  

(You will need to change the file filter in the dialogue box from ‘*.lic’ to 

‘*.dat’ before you can see this file.) 

 ‘Path to the debug log file’ = Browse to the license installation folder and type in “cadfix.log” to create 

a new log file using this name. 

 ‘Use Services’ = ✓ 

 ‘Start Server at Power Up’ = ✓ 

 
 

7. Press ‘Save Services’ 

The Windows Services tool should now show the ‘CADfix License’ service as not started: 

 
 

8. Open the LMTOOLS ‘Start/Stop/Reread’ tab, select ‘CADfix License’, and press the ‘Start Server’ 

button. 
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• The message at the bottom of the ‘Start/Stop/Reread’ tab should now say the service has started: 

 
• The Windows Services tool should now show the ‘CADfix License’ service as running: 

 
If the license service will not start, then see License service not starting. 

 

 

9. The LMTools utility program can now be exited (File → Exit). 

 

 

Note: If the ‘CADfix License’ service needs to be stopped/started/restarted, then this can be done via 

the LMTOOLS ‘Start/Stop/Reread’ tab, or via the Windows Services tool. Alternatively, this can be done 

using the Windows Services app – See Starting, Pausing and Restarting the license services. 
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4.1.1. Utilising an existing FlexNET license server 

This section is only applicable if the existing FlexNET license manager has been installed 

independently, or for another program. 

 

The version of this existing FlexNET license server must be the same, or newer, than that required by 

CADfix.  

CADfix 12 SP2.1 requires FlexNET 11.16.4 or later. 
A full list of the FlexNET version supported by each CADfix installation is shown  

on the CADfix support website (https://www.iti-global.com/cadfix-support). 

 

 

1. Copy itiohio.exe from your CADfix installation (e.g.”C:\Program Files (x86)\CADfix 13 

DX\lic\itiohio.exe”) into the existing FlexNET installation directory. This location should already have 

its own copy of “lmgrd.exe”. 

It is important that the CADfix “itiohio.exe” and FlexNET “lmgrd.exe” are in the same folder. 

If you require these to be in different locations, then please contact CADfix support for further help. 

 

2.  Copy your CADfix license file (“cadfix.dat”) onto the license server. This can be a different location 

to the “itiohio.exe” and “lmgrd.exe” files. 

 

3. Follow the instructions in section Configuring the license manager with these changes: 

 

• [Step 1 to 3]  

Run lmtools.exe from the existing FlexNET installation on your server. 

 

• [Step 6]  

When entering the values  

‘Path to lmgrd.exe file’ 

‘Path to license file’ 

‘Path to the debug log file’ 

use the location from the existing FlexNET installation on your server. 
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4.1.2. License service not starting 

Depending on the computer configuration of local administration rights, the CADfix Licence may not 

start and will display the following message: 

 
 

1. Start the Windows Services tool and Right-click on the service 'CADfix license' 

2. Select Properties. 

3. Change "log on as" from 'This account' to 'Local System account': 

 
 

4. Restart the license service. 

5. If the license service still does not start, then contact CADfix support for further help. 
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4.2. Recording License server information 

During the configuration of the CADfix License (Configuring the license manager) a ‘Path to the debug 

log file’ was specified (e.g.“C:\Program Files (x86)\CADfix\lic\cadfix.log”).  This log file contains the 

license server’s configuration and license activities. 

Open the log file with a text editor then find and record the following information: 

 FLEXnet version number:  ...................................................................  

 Server network name or IP address:  ...................................................................  

 License file name and path:  ...................................................................  

Lmgrd (license manager daemon) port number:  ...................................................................  

 Itiohio (vendor daemon) port number:  ...................................................................  

 Itiohio (vendor daemon) version number:  ...................................................................  

 Method of linking to license server:  Local license  Short license  Environment variable 

 

The following is an extract from a cadfix.log file with this key information highlighted: 

  

FlexNET version number 

Server network name or IP address 

License file name and path 

Lmgrd port number 

Itiohio port number 

Itiohio version number 



CADfix Installation Guide for Windows - CADfix 13.0 

Public 
ITI - International TechneGroup Limited  Page 19 of 37 

 

 

 

4.3. Checking the license server status 

 

Start LMTOOLS.exe 

Server status tab 

‘Perform Status Enquiry’ 

 

 

1. Using the file browser, open the CADfix license server installation folder. 

 

2. Run lmtools.exe to start the License manager interface tool.  

 
 

3. If the User Account Control dialogue box appears, click ‘Yes’ to 

allow ‘LMTOOLS Utility’ to run. 

 

 

4. When LMTOOLS starts, open the ‘Server Status’ tab, and 

press the ‘Perform Status Enquiry’: 
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4.4. Starting, Stopping, and Restarting the License Services 

 

1) Start the Windows Services App. 

 

2) Scroll down and select the “CADfix License” service. – Be aware that this service may have been 

named differently during the initial CADfix installation. 

 
 

3) The Action dropdown menu provides options to Start, Stop, Pause, Resume, and Restart the 

license service. Some of these options will be greyed out depending on the service’s current status. 
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5. Linking CADfix to the license 
To allow CADfix to start, it needs to link to a valid license, and there are three options for this: 

When you have configured your installation, record which method you used on the form in Recording License 

server information. 

 

 

Evaluation license 

Node-locked (single seat) license 

5.1. Local license file 

Check the license file has been copied into the client’s local “[CADfix installation]\lic” folder.  

 

 

Floating and Multi-seat node-locked licenses 

5.2. Environmental variable 

An environmental variable can be set up for each user, this tells CADfix how to contact the 

server: 

CADFIX_KEY=[lmgrd port]@[server name] 

 e.g. 

CADFIX_KEY=32768@mainland 

The actual values used in this variable can be found in the license server log file. 

 

 

5.3. Local license file 

Copy the license file into the client’s local “[CADfix installation]\lic” folder.   

 

 

5.4. License connection errors 

If an error occurs when CADfix is trying to communicate with the license server, then a ‘FlexNET 

license finder’ error will be displayed. – Cancel this error. 

This will then be followed with a ‘Fatal error’ message which will show the full error text – take a 

screenshot of this so you can share it with CADfix support. 

Following an installation, the biggest cause of license errors is because a firewall has blocked 

communications on ports that are being used by the license server. These port numbers are shown in 

the license log file (see ‘lmgrd port number’ and ‘itiohio port number’ in Recording License server 

information). 

1. The CADfix license server needs firewall exceptions to allow inbound communications on the 

‘lmgrd’ and ‘itiohio’ ports. 

2. CADfix client machine (running CADfix) should not need any exceptions to its firewall. 

For further support on licensing problems, please contact CADfix support.  
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6. Updating CADfix 
 

6.1. Updating your CADfix installation 

As part of the Maintenance, Enhancements, and Support (ME&S) package, you will be offered an 

upgrade for your CADfix.  

 

For most CADfix releases, the license manager will remain unchanged, and will therefore not need 

upgrading. If the license manager does need upgrading, then this will be highlighted in the “What’s 

new…” release document.  

 

Service packs are supplied with their own installation instructions. 

 

Evaluation license 

If you are using an evaluation license of CADfix, then you will just need to uninstall your current CADfix 

installation and then install the newer version. – see Installing CADfix 

 

 

Node-locked (single seat) license 

If you are using a node-locked license where the license server is part of the CADfix installation you are 

using, then: 

 

Recommended 

1) Stop the license service – See Starting, Pausing and Restarting the license services 

2) (Optionally) uninstall your existing CADfix installation (this will also uninstall the license server files) 

3) Install the new version of CADfix – See Installing CADfix 

4) Configure the license services using this new installation – See Configuring the license manager 

 

Alternatively, follow the procedure for ‘Floating and Multi-seat node-locked licenses’ to reconfigure 

CADfix to get its license from your existing license server. If the FlexNET licensing service has been 

updated in the new release, then this license server will also need updating - Contact CADfix support 

for more information. 

 

 

Floating and Multi-seat node-locked licenses 

1) (Optionally) uninstall your existing CADfix installation. 

2) Install the new CADfix installation – See Installing CADfix 

3) Link CADfix to license server if needed. If the variable ‘CADFIX_KEY’ has been used here, then this 

step is not needed – See Linking CADfix to the license 

4) If the license manager needs updating, then see Upgrading license service files 
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6.2. Updating your license file 

Periodically the license file you have been provided with will expire.  If this happens and you have not 

yet received an updated file, then contact your CADfix supplier. 

 

6.2.1. Evaluation license 

If you are using an evaluation licence, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into “CADfix 13 DX\lic”.  -  Any existing license file can be 

overwritten. 

c) Restart CADfix, and it will automatically read this new license file. 

d) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licences, and the new license expiration date. 

 

6.2.2. Node-locked (single seat) license 

If you are using a node-locked license and running through a license file that is part of your 

CADfix installation, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into “CADfix 13 DX\lic”.  - Any existing license file can be 

overwritten. 

c) Restart the FlexNET services – See Starting, Pausing and Restarting the license services 

d) Restart CADfix and it will automatically read this new license file. 

e) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licences, and the new license expiration date. 

 

6.2.3. Floating and Multi-seat node-locked licenses 

If you are using a floating license as part of your CADfix installation, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into “CADfix 13 DX\lic”.  - Any existing license file can be 

overwritten. 

c) Restart the FlexNET services – See Starting, Pausing and Restarting the license services 

d) If you have linked your CADfix installation to the license service using a full license file, then 

copy the new license file into the “CADfix 13 DX\lic” folder on the local CADfix client 

machine. 

e) Restart CADfix and it will automatically read this new license file. 

f) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licences, and the new license expiration date. 
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6.3. Upgrading license service files 

This process upgrades the full FlexNET installation. If you share your FlexNET installation with other 

packages, then see section Upgrading FlexNET itiohio.exe only. 

 

1) Pause the license service – See Starting, Pausing and Restarting the license services 

 

2) Copy new FlexNET license service files into the lic folder to replace the existing ones. 

The list of files include: lmtools.exe, lmutil.exe, lmgrd.exe, and itiohio.exe 

 

3) Check you have the latest license file in the CADfix\lic folder.  This should have an expire date after 

today, and valid to operate with this version of CADfix. – Speak to CADfix support to verify this. 

 

4) Restart the license service – See Starting, Pausing and Restarting the license services 

 

 

 

 

6.4. Upgrading itiohio.exe only 

This section is only applicable if the existing FlexNET license manager has been installed 

independently, or for another program. 

 

1) Check the version of this existing FlexNET license server is the same, or newer, than that required 

by CADfix.  

CADfix 12 SP2.1 requires FlexNET 11.16.4 or later. 
A full list of the FlexNET version supported by each CADfix installation is shown  

on the CADfix support website (https://www.iti-global.com/cadfix-support). 

 

2) Pause the license service – See Starting, Pausing and Restarting the license services 

 

3) Copy new “itiohio.exe” file from your updated CADfix\lic folder, and into the server lic folder to 

replace the existing “itiohio.exe”. 

 

4) Check you have the latest license file in the CADfix\lic folder.  This should have an expire date after 

today, and valid to operate with this version of CADfix. – Speak to CADfix support to verify this. 

 

5) Restart the license service – See Starting, Pausing and Restarting the license services 

 

  

https://www.iti-global.com/cadfix-support
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7. Configuring CADfix 
 

7.1. Changing the display language 

The CADfix interface language is set during the installation by creating a system environment variable. 

e.g. 

CADFIX_LANGUAGE=English 

 

To change the display language, set the CADFIX_LANGUAGE variable to “English”,“German”, or 

“Japanese” 

• If the CADFIX_LANGUAGE environment variable is deleted or is not set to a valid value, then 

CADfix will default to using English. 

• If CADFIX_LANGUAGE is also set up as a User Environment Variable, this value will override 

the System Environment Variable. 

 

Allowable values: 

CADFIX_LANGUAGE=English 

CADFIX_LANGUAGE=German 

CADFIX_LANGUAGE=Japanese 
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7.2. Custom Configuration Files 

 

7.2.1. User Configuration Files 

Each CADfix user has their own configuration file that is saved when CADfix is closed. Alongside this 

file is a set of configuration directories used to store other configuration files saved during the session. 

This file is saved in the user’s home directory and stores the CADfix settings used during the last 

session (note the leading “.”). 

%HOME%\.CADfix1300 

%HOME%\ .CADfix.config\ 

e.g. “C:\Users\xxx\.CADfix1300” 

• When CADfix is restarted, this local configuration file is read and used to configure the new 

session. 

• If a local ‘.CADfix1300’ file does not exist, CADfix will start with its default settings.  

• If this local ‘.CADfix1300’ file is deleted, CADfix will start with its default settings and any 

customisation or environment changes will be lost. 

 

7.2.2. Site Configuration Files 

It may be advantageous for an organisation to have all its CADfix users share a common configuration. 

This configuration will contain only settings common to all users and allows the users to set the other 

values to suit their needs. 

A site configuration file is referenced by setting the users’ environment variable “CADFIXSITECONFIG”. 

This will either reference a shared configuration directory or a specific configuration file. 

• If a local configuration file does not exist, the site configuration file will be used as a template for 

the new local file. 

• If a local configuration file already exists, its values will override the site configuration unless the 

local file is deleted, or the specific site value is enforced (see below). 

The CADFIXSITECONFIG environmental variable can be set in different locations depending on how 

the organisation would like to control its use: 

1. System environment variables 

 – Gives a consistent value for all users. 

2. User environment variables 

 – Gives a consistent value for each user and allows for users to have different values.  

3. Set the user environment variable via a script run by the user 

 – This allows users to set the environment variable as required. The value is retained until reset 

by running another script. 

4. Set in the CADfix startup script (startCADfix.bat) 

 – This method resets the environment variable every time CADfix is started. 
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Referencing a configuration directory 

This method is good for setting a general set of configuration values for all users who share a common 

use of CADfix. 

Set the environmental variable CADFIXSITECONFIG to set the shared configuration directory, e.g. 

CADFIXSITECONFIG=S:\Shared\CADFixConfig 

The referenced shared configuration directory must contain a configuration file called “CADfix1300” 

(without a leading “.”). 

 

Referencing a configuration file 

This method is good for setting different configuration values for different groups of users, such as 

projects or departments. 

 

Set the environmental variable CADFIXSITECONFIG to set a specific shared configuration file, e.g. 

CADFIXSITECONFIG=S:\Shared\CADFixConfig\project_a.config 

This configuration file can use any naming format. 

 

Content of the shared configuration file 

The shared configuration file can contain the same information as a local ‘.CADfix1300’ file. It is 

therefore recommended that the required settings be copied from a local ‘.CADfix1300’ file into the 

shared configuration file. 

Here are examples of some of the settings that are commonly used in a site configuration file: 

*famgui.workingDirectory: C:/temp 

*famgui.dirsFavourites: C:/temp S:/Shared/ “H:/CAD/Prod Models” “H:/Analysis Results”  

*famgui.backgroundcol: K 093EBB bottomTop 

*famgui.wizardConfig: S:/Shared/CADFixConfig/Wizard/STEPtoCAE.cwc 

*famgui.wizardMaxTol: 0.1 mm 

*famgui.qualityStandard: user standard1 {}  

*famgui.usertools: ***** 

*famgui.usertoolboxes: ***** 

 

Note that the wizardMaxTol and the qualityStandard values can also be set in the wizardConfig file. 

Care must be taken to ensure these values do not contradict each other. 
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7.2.3. Installation Configuration Files 

An alternative to the Site Configuration File is to place a default configuration file into the CADfix 

installation, e.g. 

C:\Program Files (x86)\CADfix 13.0\defaults.config 

 

• This file can have any name but must have the extension “.config”. 

• All users of this CADfix installation will inherit this file. 

• Users do not need the environmental variable “CADFIXSITECONFIG” setting. 

 

 

 

7.2.4. Enforcing configuration settings 

When a user changes any CADfix configuration setting, it is stored in their local configuration file 

(‘.CADfix1300’), and this will override any values set in the site configuration file. The values in the 

shared configuration file can be set to override any local values through the use of the ‘siteonlyoptions’ 

setting. 

Note that a user can still manually use alternative settings. The ‘siteonlyoptions’ should therefore not be 

considered as a way of controlling the users’ settings, it is rather an aid to loading default values. 

The ‘siteonlyoptions’ setting is added to the top of the site configuration file and lists all the configuration 

values that must not be overridden.  

In the following example of a site configuration file, only the wizardMaxTol and workingDirectory are set. 

All the other values can be overridden by the users’ local configuration file. 

*famgui.siteonlyoptions: wizardMaxTol workingDirectory 

*famgui.workingDirectory: C:/temp 

*famgui.dirsFavourites: C:/temp S:/Shared/ “H:/CAD/Prod Models” 

*famgui.wizardConfig: S:/Shared/CADFixConfig/Wizard/STEPtoCAE.cwc 

*famgui.wizardMaxTol: 0.1 mm 
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Appendix: Error messages 
Any code examples in the following explanations uses example settings. Review your own settings to 

identify your specific values for these examples – See Recording License server information. 

1. CADfix errors 

1.1. Authorisation key file does not exist. 

 
 

CADfix cannot locate the license file.   

If using a license file, then copy the license file to the location shown in the error message:  

“[CADfix installation]\lic\cadfix.dat” – See Local license file 

 

Alternatively, set the CADfix_KEY environmental variable to point to the license files location or 

the license service address. e.g. – See Environmental variable 

 

• The default location of the license for all CADfix versions (including evaluation licenses) is 

the lic folder in the CADfix installation directory. e.g. c:\Program Files (x86)\CADfix 12 DX\lic 

• The license file should be named cadfix.dat 

• If the CADfix_KEY environmental variable is used to locate a license server, then its values 

must match those in the license server log file. 

 

1.2. Can’t find a usable init.tcl in the following directories. 
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This error usually occurs when CADfix has been 

pinned to the Windows taskbar - This action is not 

supported. 

The user should either start CADfix from the Windows 

Start menu, or set up a desktop shortcut to the 

“..\CADfix\startCADfix.bat” file.  



CADfix Installation Guide for Windows - CADfix 13.0 

Public 
ITI - International TechneGroup Limited  Page 31 of 37 

2. FlexNET errors 
 

If a licensing error occurs, the following error message will be displayed. 

 

 

 

 

To diagnose the problem, press the ‘Cancel’ button, 

and a further dialogue will be displayed containing the 

relevant error message. 

 

 

 

 

 

 

 

 

 

 

 

 

The start of the message starts with a description of 

the problem and the ‘FlexNet Licensing error’ on the 

bottom line. 

Record the ‘FlexNet Licensing error’, or take a 

screenshot to send to CADfix support. 

If available, you will also need a copy of the license 

log file. See Recording License server information 
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2.1. Cannot find license file (error:-1,xxx) 

 
 

CADfix cannot locate the license file or the details for connecting to the license server.  The 

locations where it is looking in are shown in the error message. 

 

See error Authorisation key file does not exist.. 

 

 

 

 

2.2. Licenced number of users already reached (error:-4,xxx) 

 
 

There are too many CADfix sessions being run. Someone must close CADfix before another 

feature (named in the message) can be used. It may be that: a user has started CADfix and left 

it running, a batch script may be running CADfix, or a license has been locked out following a 

crash.  

The license should be freed automatically 15 minutes after a crash. 

 

Use the command "lmutil lmstat” command to identify who is using CADfix, and arrange for one 

of the users to close CADfix: 

 cd C:\Program Files (x86)\CADfix\lic 

 lmutil lmstat -c 12345@server -A"  

 or  

 lmutil lmstat -c C:\CADfix\lic\cadfix.dat -A"  
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2.3. No such feature exists (error:-5,xxx) 

 
 

A license is found, but the feature you are trying to use does not exist in the license or cannot 

be used due to an encoding error. - Please contact CADfix support to verify your modules and 

check your license file. 

 

 

 

2.4. Invalid (inconsistent) license key (error:-8,xxx) 

1. Error using local license file: 

 
2. Error when using a license server: 

 
 

An inconsistency has been detected with the license encryption. Please get the license file 

checked by CADfix support. 

 

With a license server, this is also caused when the vendor daemon (itiohio) is not reachable. 

This may be the vendor daemon’s port is blocked. – License connection errors 

Ensure the port is available and is explicitly opened as an exception in the server’s firewall (see 

“Port and Firewall settings”). 
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2.5. Invalid host (error:-9,xxx) 

 
 

The workstation attempting to run CADfix does not match the allowed list of clients in the license 

file. Either the computer's IP address is not in the license, or the mac address does not explicitly 

match. If you are running CADfix from a remote computer, then this may change the credentials 

being used. 

 

Either: move CADfix onto a valid CADfix client or contact CADfix to discuss your license options. 

 

 

 

2.6. Invalid return data (error:-12,16) 

 
 

In the only case where I have seen this error, all FEATUREs in license file had expired. - This 

was stated in the license log file. 

No other user activity was shown in the license log. 
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2.7. Cannot connect to server system (error:-15,xxx) 

 
 

CADfix has details to connect to the license server (either from a local license file, or 

CADFIX_KEY), but it is not getting a response. 

It may be that: 

1) The wrong license server details are being used in CADFIX_KEY, or an old license file is 

in the \lic folder. 

2) The license server services may not be running. 

3) Communications to the server may be blocked by a firewall. 

 

Verify details of point 2 and 3 in the license server’s log file. 

 

 

 

 

2.8. License server does not support this version of this feature. (error:-25,xxx) 

 
  

The user is trying start up a newer version of CADfix than is allowed by the license file.  

E.g. the license is for 12.0 and they are trying to start 13.0 . 
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2.9. User/host not on INCLUDE list for feature. (error:-39,xxx) 

 
  

An option file is in use to define a user list. The users are not found in this list because: 

1) Their name has not been added to the list. 

2) An error occurs in the list (e.g. too many characters in the list’s line) 

 

 

2.10. License server machine is down or not responding (error:-96,xxx) 

  
 

The CADFIX_KEY or local copy of the license file references the license server by name, but it 

cannot be contacted.  

It may be: 

1) The license server is down. 

2) The server may not be reachable by this name and should be replaced by another name 

or IP address. 

3) Or the wrong license file is being used. 

 

 

2.11. The desired vendor daemon is down (error:-97,xxx) 

 
 

The vendor daemon (itiohio) is not running. This is because the daemon will not start, or 

communication to it is being blocked (possibly by a firewall). 

Check the license log file to see if it is still running.  

If the itiohio daemon is running, check there are no firewalls blocking the port number it is using.  
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2.12. Cannot checkout an uncounted license within a Windows Terminal 

Services… (error:-103,xxx) 

 
 

The user is accessing a CADfix client machine via Terminal Services to run CADfix. The CADfix 

license is node locked to only allows CADfix use on the client machine, not the display computer 

where the user is located. 

Either: the user must work directly on the licensed CADfix client or contact CADfix to discuss 

your license options. 

 

2.13. FlexNET Licensing Error (error:-140,148) 

 
 

The license server is using an older version of FlexNET than the version of CADfix being run. 

Upgrade the license server to match the version of CADfix being used (or later). 

 

 

2.14. Invalid licensing for this product 

 
The CADfix startup settings are wrong. - Please contact CADfix support to verify your 

installation. 

 


